
 

Kartono Pramdhan, 2021 
DAMPAK TACTICAL PERIODIZATION DAN POSISI PEMAIN TERHADAP RESPON FISIOLOGI 
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

80 

BAB III 

METODE PENELITIAN 

Pertimbangan suatu penelitian terkait pemacahan permasalahan tertentu perlu 

menggunakan metode ilmiah yang tepat. Penelitian adalah penyelidikan sistematis untuk 

mendeskripsikan, menjelaskan, memprediksi, dan mengontrol fenomena yang diamati. 

Oleh karenanya peneliti dapat memperoleh gambaran dan prosedur yang digunakan untuk 

menjawab permasalahan penelitian yang diajukan, metode penelitian merupakan 

ungkapan keterkaiatan sebab dan akibat diantara variabel dimana akan dimanipulasi 

variabel independent (Fraenkel et al., 2013, hlm. 265). Oleh karenanya variabel yang 

dimanipulasi pada penelitins ini adalah tactical periodization dan posisi pemain sebagai 

varibel moderator. Sedangkan variabel dependen didalam penelitian ini menggunakan 

respon fisiologi yang terdiri dari distance, work rate, hate rate average, hate rate max, 

speed average, dan body load. 

3.1 Desain Penelitian 

Desain factorial digunakan dalam penelitian ini. Desain factorial yang digunakan 

merupakan kajian penggabungan pengaruh daripada vaiabel bebas. Maka, peneliti dapat 

mengetahui bagaimana salah satu variabel menjadi penengah dari varibel yang lainya atau 

yang disebut variabel moderator (Fraenkel et al., 2013, hlm. 277).  

Berdasarkan kepada kebutuhan penelitian yang memaparkan bahwa untuk respon 

fisiologi pemain akan ada posisi pemain yang mengiringi. Maka, dalam penelitian ini juga 

ingin mengkaji interaksi antara Tactical Periodization dan posisi pemain (posisi sektor 

belakang, sektor tengah dan sektor depan)  sehingga desain dikembangkan menggunakan 

faktorial 2x3. Banyak variasi tambahan juga dimungkinkan, seperti desain 3x3, 4x3, dan 

2x3 (Fraenkel et al., 2013, hlm 279). Desain faktorial dapat digunakan untuk menyelidiki 

lebih dari dua variabel, meskipun jarang lebih dari tiga variabel dipelajari dalam satu 

desain. 

Rancangan faktorial digunakan apabila eksperimen terdiri atas dua faktor atau 

lebih. Desain faktorial memungkinkan kita melakukan kombinasi antar level faktor. 
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Olehkarena itu penelitian ini memakai desain 2x3 yang disesuaikan dengan pendapat 

Kerlinger (2002, hlm.90). Pada kelompok penelitian diterapkan perlakuan Tactical 

Periodization. Nilai lain dari desain faktorial adalah memungkinkan peneliti untuk 

mempelajari interaksi variabel independen dengan satu atau lebih variabel lain, kadang-

kadang disebut variabel moderator. Variabel moderator dapat berupa variabel perlakuan 

atau variabel karakteristik subjek (Fraenkel et al., 2013, hlm.277). Secara garis besar 

sepakbola terdiri dari beberapa sektor posisi pemian seperti: belakang, tengah, dan depan. 

Dengan adanya pembagaian posisi tersebut dirasakan akan memberikan perbedaan 

performa dalam setiap sektor posisi tersebut, maka dalam penelitian ini yang menjadi 

variabel moderatornya adalah posisi pemain yaitu posisi belakang, Tengah dan depan 

untuk desain penelitian dapat dilihat pada gambar dibawah ini: 
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Kelompok Eksperimen 2 dengan Tactical Periodization Direct 

Play  Posisi Pemain Belakang 

Kelompok Eksperimen 1 dengan Tactical Periodization Ball 

Possesion Posisi Pemain Tengah 

Kelompok Eksperimen 2 dengan Tactical Periodization Direct 

Play Posisi Pemain Tengah 

Kelompok Eksperimen 1 dengan Tactical Periodization Ball 

Possesion Posisi Pemain Depan 

Kelompok Eksperimen 2 denga Tactical Periodization Direct Play 

Posisi Pemain Depan 

 

3.1.1 Definisi Operasional Variabel 

Operasional variabel merupakan hal yang penting sebagai informasi untuk 

menghindari kesalahpahaman pada saat pengambilan data dari sebuah penelitian. 

Variabel yang digunakan dalam penelitian ini menggunakan tiga variabel yaitu: varibel 

bebas, variabel terikat, dan variabel moderator. 

1) Variabel Independen/ Bebas 

Variabel ini sering disebut sebagai variable stimulus, predictor, antecedent. 

Dalam Bahasa Indonesia sering disebut sebagai variable bebas. Variabel bebas 

merupakan variable yang mempengaruhi atau yang menjadi sebab perubahannya atau 

timbulnya variable dependen (terikat). Dalam penelitian ini yang menjadi varibel bebas 

adalah Tactical Periodization yang diterapkan pada tim elite sebagai kelompok 

eksperimen 1 dan tim elite sebagai kelompok eksperimen 2.   

2) Variabel Dependen/ Terikat 

Variabel ini sering disebut sebagai variable output, kritera, konsekuen. Dalam 

Bahasa Indonesia sering disebut sebagai variable terikat. Variabel terikat merupakan 

variable yang dipengaruhi atau yang menjadi akibat, karena adanya variable bebas yaitu 

respon fisiologi yang terdiri diri dari: distance, work rate, hate rate average, hate rate 

max, speed average, speed max, dan body load. 

3) Variabel Moderator 

Variabel Moderator adalah variabel yang mempengaruhi (memperkuat dan 

memperlemah) hubungan antara variabel independen dengan dependen. Variabel disebut 

juga sebagai variabel independen kedua. Dalam penelitian ini yang menjadi varibel 
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moderator adalah posisi pemain yaitu pemain dengan posisi pemain belakang, posisi 

pemain tengah dan posisi pemain depan. 

 

3.1.1.1 Definisi Operasional Variabel Tactical Periodization 

Dalam penelitian ini Tactical Periodization merupakan dinamika latihan 

mingguan dimana materi latihan terdiri dari model dari permainan tim,  dan skema 

pemulihan untuk penampilan terbaik dalam pertandingan, skema ini hampir tidak berubah 

sepanjang musim. Performa dan latihan sepakbola tidak lepas dari persaingan kompetisi 

dan gaya permainan tim. Hal Ini semuanya harus diterjemahkan dalam sebuah pelatihan 

dengan menggunakan pendekatan kualitas daripada kuantitas, materi latihan tidak 

terlepas dari prinsip menyerang, bertahan dan transisi. 

Bordonau & Villanueva (2018, hlm. 110) mengatakan bahwa sepakbola 

merupakan permainan sebagai sistem yang kompleks. Berikut ini faktor yang perlu 

diperhatikan untuk memenuhi kompleksitas dalam sepakbola: 

1) Level Individual Pemain  

2) Sektoral & Grup (tindakan yang melibatkan pemain dari lini yang sama atau 

kelompok kecil yang terdiri dari 2 atau 3 pemain dari lini berbeda) 

3) Intersektorial (hubungan antar sektor) 

4) Kolektif (seluruh tim). Ketika kami mengambil jumlah interaksi sebagai indikator 

kompleksitas, itu meningkat dari individu ke tingkat organisasi kolektif. 

Tactical Periodization didalamnya suatu pembentukan dan pemecahan dari 

prinsip inti, sub-prinsip dan sub-sub prinsip dari gaya permainan tim di dalam rencana 

mingguan dan selama beberapa minggu, sesuai dengan evolusi para pemain dan tim. 

Prinsip metodologis ini memiliki dua tingkatan perencanaan yang berinteraksi satu sama 

lain: 

1) Jangka Pendek (game ke game) 

2) Jangka Menengah / Panjang (gaya permainan atau model permainan) 

Perkembangan kompleks ini dicapai dengan memprioritaskan prinsip-prinsip permainan 

dan mengubah tingkat usaha (beban latihan) sepanjang minggu. Karena itu, di samping 

cara bermain yang diinginkan, ada kekhawatiran mingguan tentang pergantian pola usaha 
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dan pemulihan yang berbeda. Frade (2007) dalam Bordonau & Villanueva (2018) 

menyatakan bahwa apa yang dilatih setiap hari berbeda karena kompleksitas yang lebih 

besar atau lebih kecil dengan konsekuensi tertentu untuk cara bermain yang diinginkan. 

Seperti disebutkan sebelumnya, struktur prinsip permainan memungkinkan 

pengembangan dimensi fisiologis menjadi spesifik (sesuai dengan model permainan yang 

diinginkan). Pola siklus mingguan selalu mempertimbangkan evolusi tim, dengan kata 

lain terdapat peningkatan kompleksitas untuk setiap prinsip / tindakan yang dipelajari. 

Oleh karena itu, struktur pola mingguan ini dijaga agar memenuhi prinsip stabilisasi yang 

dipadukan dengan mempertimbangkan tingkat kelelahan mental dan fisik untuk 

pemulihan. Perbedaan program dari kedua treatment akan dijelaskan dibawah ini: 

Tabel 3.1. 

Perbedaan Program Perbedaan Pre-Sesaon Kelompok Eksperimen 1 Dan Kelompok 

Eksperimen 2  Sebelum Kick Off  Liga Indonesia 
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Dilihat dari program general dari kedua tim diatas dapat dilihat bahwa kelompok 

eksperimen 1 lebih bervariasi dibandingkan tim elite sebagai kelompok eksperimen 2. 

Hal ini disebabkan beberapa faktor diantaranya : (1). Kualitas pelatih, (2). Kualitas 

Pemain (level fitness dan lain-lain, (3). Keprofesionalan dan kondisi Manajemen tim 

Berdasarkan kepada penerapan Tactical Periodization diatas baik pada Tim elite 

kelompok eksperimen 1 dan pada tim elite kelompok eksperimen 2, untuk lebih lengkap 

tentang scenario dari program latihan penerapan program Tactical Periodization dapat 

dilihat pada lampiran 1 dan lampran 2. Berikut salah satu contoh secara rinci program 

latihan pada tim elite kelompok eksperimen 1  dan tim elite kelompok eksperimen 2:  

 

27  

 

4/ Rabu Training Training 

28 5/ Kamis Friendly Match   Training 

29 6/ Jumat Recovery Rest 

30 7/ Sabtu Friendly Match   Rest 

31 

2 

1/ Minggu Recovery 

Personal 

Training 

32 2/ Senin Rest Training 

33 3/ Selasa Friendly Match   Training 

34 4/ Rabu Recovery 

Personal 

Training 

35 5/ Kamis Recovery 

Personal 

Rest 

36 6/ Jumat Traveling Rest 

37 7/ Sabtu Friendly Match   Rest 

38 

3 

1/ Minggu Traveling  Training 

39 2/ Senin Friendly Match   Rest 

40 3/ Selasa Traveling Rest 

41 4/ Rabu Rest Training 

42 5/ Kamis Training Training 

43 6/ Jumat Friendly Match   Rest 

44 7/ Sabtu Recovery 

Personal 

Rest 

45 

4 

1/ Minggu Rest Rest 

46 2/ Senin Training Training 

47 3/ Selasa Training Match 

48 4/ Rabu Archery Training Training 

49 5/ Kamis Rest Match 

50 6/ Jumat Rest Rest 

51 7/ Sabtu Indonesia League  
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Gambar 3.2. Program Latihan Harian Pertemuan Ke 3 Dengan Penerapan 

Tactical Periodization Pada Tim Elite sebagai kelompok eksperimen 1 

 
 

Gambar 3.3. Program Latihan Harian Pertemuan Ke 3 Dengan Penerapan 

Tactical Periodization Pada Tim Elite sebagai eksperimen 2 
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Melihat dari program diatas maka diperoleh data untuk respon fisiologi dengan 

menerapkan tactical periodisasi dengan latihan mingguan, yang berdasarkan 8 minggu 

sesi latihan. Kedua program diterapkan oleh kedua head coach dengan menggunakan 

tactical periodization. Selain itu kedua kelompok penelitian masuk kedalam tim elite 

sehingga harus dapat memenuhi konsep metodologi tactical periodization agar dapat 

lebih optimal. Program Latihan dari kedua tim elite tersebut diatas adalah dari pelatih 

kepala kedua tim elite tersebut yang memiliki lisensi kepelatihan lisensi tertinggi di 

cabang sepak bola yang merupakan regulasi dari federasi sebagai syarat untuk menjadi 

pelatih kepala di tim Liga Profesional. Selain itu berkaitan dengan surat balasan dari 

setiap tim elite yang menjadi tempat penelitian memberikan kode etik yaitu :  

1. Data bersifat anonim (nama pemain disamarkan). Sehingga data yang 

diberikan hanya berdasarkan posisi (Posisi belakang, tengah dan depan). 

2. Data yang diberikan adalah data-data yang bersifat umum, bukan data 

yang spesifik. Sehingga daya yang diperoleh bersifat general yang didapat 

dari catapult 

3. Data tersebut bersifat rahasia, dan hanya akan digunakan penulisan 

disertasi ini saja. Sehingga dalam hal ini peneliti merubah bentuk dan 

program dari setiap sesi Latihan. Oleh karena itu untuk penyusunan sesi 

Latihan peneliti menggunakan aplikasi “Tactical Manager” 

 

3.1.1.2 Definisi Operasional Variabel Respon Fisiologi  

Tuntutan fisiologi dari permainan sepak bola ditunjukkan oleh intensitas latihan 

sesuai juga dengan berbagai aktivitas selama pertandingan. Karena latihan dan 

pertandingan yang disesuaikan dengan jadwal kompetisi, berhubungan dengan kebutuhan 

dan pengeluaran energi setiap kinerja dari pemain. Intensitas latihan selama pertandingan 

sepakbola dapat ditunjukkan oleh jarak keseluruhan yang ditempuh. Ini merupakan 

ukuran tingkat kerja global yang dapat dipecah menjadi tindakan terpisah dari pemain 

individu untuk seluruh permainan. Tindakan atau aktivitas dapat diklasifikasikan menurut 

jenis, intensitas (atau kualitas), durasi (atau jarak) dan frekuensi (Thomas Reilly & Mark 

Williams, 2003). Respon fisiologis pemain memiliki peran penting dalam latihan dan 
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penampilan dalam pertandingan selama kompetisi, karena dapat mempengaruhi pada 

kualitas keterampilan individu dan taktik tim yang dieksekusi. 

Salah satu faktor sebagai tuntutan fisiologi dari permainan sepakbola adalah jarak 

yang ditempuh pemain dalam latihan dan pertandingan, dan juga mempertimbangkan 

jarak tempuh pemain dengan posisi yang berbeda di timnya. Idealnya, pemain harus 

mampu mempertahankan usaha yang sama selama sepanjang permainan. Didalam 

permainan terjadi penurunan jarak yang ditempuh oleh pemain, perubahan intensitas 

tinggi hingga intensitas rendah, detak jantung dan tingkat laktat semuanya menunjukkan 

penurunan tingkat aktivitas saat permainan berlangsung. Namun, ada alasan yang tidak 

terkait dengan kebugaran yang memengaruhi tingkat aktivitas selama pertandingan, 

diantaranya kurangnya motivasi mungkin merupakan faktor yang signifikan, atau 

perubahan dalam strategi bermain. Namun, mungkin ada langkah-langkah yang dapat 

diambil pemain yang dapat mempertahankan hasil kerja saat diperlukan (Tumilty, 1993). 

Dalam penelitian ini respon fisiologi dilihat dengan menggunakan Catapult untuk 

memperoleh data. Diantaranya adalah distance, work rate, hate rate average, hate rate 

max, speed average, speed max, dan body load. 

1) Distance  

Distance adalah jarak yang ditempuh pemain selama sesi latihan dan 

pertandingan. Jarak yang ditempuh memberikan gambaran terkait mobilitas pemain, baik 

itu dengan bola atau tanpa bola. Pencapaian jarak tempuh salah satunya di pengaruhi oleh 

kondisi fisik pemain. Persiapan fisik jelas merupakan salah satu elemen yang paling 

berkembang dalam dua dekade terakhir pada metod pelatihan. Tujuan dari persiapan fisik 

yang benar dalam latihan adalah untuk memungkinkan pemain menggunakan kapasitas 

teknis, taktis, mental dan jarak yang ditempuh secara maksimal dan selama mungkin 

sepanjang pertandingan dan bahkan sepanjang musim (Barnerat et al., 2002). Dalam 

memperoleh data Distance pemain menggunakan Catapult, dimana hasil output Catapult 

diukur dalam satuan meter. 

2) Work Rate  

Work Rate jumlah usaha yang dilakukan pemain atau tim dalam olahraga (sepak 

bola, rugby, dll) dalam permainan, terutama ketika mereka tidak memiliki bola. Dalam 
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sepak bola, tingkat kerja mengacu pada sejauh mana seorang pemain berkontribusi untuk 

berlari dan mengejar bola atau lawan dalam pertandingan saat tidak memiliki bola. Work 

rate yang tinggi dinilai karena pemain dengan karakteristik seperti ini akan dapat 

berperan lebih aktif dalam bertahan dan menyerang sepanjang pertandingan. Sebaliknya, 

pemain terkadang dikritik karena tingkat kerja yang rendah. Work Rate dalam penelitian 

ini merupakan jarak latihan dibagi menit latihan menggunakan Catapult. 

3) Hate Rate Avarage 

Hate Rate adalah gelombang yang dirasakan pada arteri yang diakibatkan karena 

pemompaan darah oleh jantung menuju pembuluh darah. Hak ini menentukan tingkatan 

intesitas yang dilakukan oleh pemain dalam suatu pelatihan. Hate Rate Avarage 

merupakan rata-rata denyut nadi pemain dari setiap latihan. Data ini diperoleh juga dari 

Catapult, sehingga memudahkan untuk membedakan antara zona denyut jantung di setiap 

masing-masing kinerja pemain. Data diperoleh dalam nominal dengan satuan x/menit. 

4) Hate Rate Maksimal 

Dalam pelatihan sepakbola yang menjadi pertimbangan adalah intensitas Latihan, 

oleh karenanya intensitas berhubungan dengan aktivitas yang dilakukan. Secara umum 

detak jantung akan meningkat saat melakukan aktivitas fisik, dan akan terus meningkat 

sejalan dengan intensitas gerakan yang dilakukan. Hate Rate Maksimal adalah denyut 

nadi ketika sedang melakukan aktifitas kerja atau Latihan pada zona Latihan paling 

maksimal. 

5) Speed Avarage 

Speed Avarage merupakan rata-rata dari nilai kecepatan absolut selama periode 

tertentu, yaitu beban kecepatan yang dihasilkan dari waktu ke waktu. Dengan demikian, 

kecepatan dapat digambarkan sebagai penghitungan intensitas aktivitas perubahan 

kecepatan. Speed Avarage diperoleh dengan menggunakan Catapult, sehingga setiap 

pemain dapat terlihat speed average yang dihasilkan selama Latihan atau bahkan 

dipertandingan.  

6) Speed Maksimal 

Kecepatan adalah faktor yang memungkinkan individu untuk melakukan tindakan 

motorik secepat mungkin, sebagai akibat dari berfungsinya proses neuromuskuler 
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(Barnerat et al., 2002). Data speed maksimal diperoleh dengan menggunakan Catapult. 

Sehingga batasan dari jarak yang ditempuh dan kecepatan yang diperoleh oleh pemain 

dapat terukur dengan pertimbangan pergerakan intensitas tinggi yang terjadi pada saat 

latihan atau pertandingan, seperti akselerasi dan deselerasi. Ini sangat penting di mana 

kebutuhan dari setiap posisi pemain cenderung bekerja di ruang yang lebih kecil dan 

terbatas. oleh karenanya penggunaan Catapult untuk mengetahui kecepatan rata-rata 

sebagai cara untuk mengukur apa yang dapat digambarkan sebagai jumlah aktivitas 

kecepatan. 

7) Body Load  

Body Load adalah jumlah usaha dari semua aktivitas internal selama gerakan 

pelatihan. Ini memperhitungkan tingkat perubahan akselerasi seketika dan membaginya 

dengan faktor penskalaan (dibagi 100). Faktor penskalaan digunakan untuk mengurangi 

nilai total Beban Akumulasi Pemain sehingga lebih mudah untuk dikerjakan selama 

analisis. Parameter ini memberikan informasi seberapa banyak pekerjaan yang dilakukan 

pemain selama sesi latihan atau permainan. Hal ini adalah pengukur total volume 

pekerjaan yang dilakukan. Misalnya, seorang pemain yang memiliki Body Load Total 

300 melakukan pekerjaan 50% lebih banyak daripada pemain yang memiliki Beban 

Pemain Total 200. Angka ini paling baik digunakan untuk mengevaluasi seberapa banyak 

pekerjaan yang telah dilakukan pemain tertentu dari waktu ke waktu atau untuk 

membandingkan seberapa banyak pekerjaan yang dilakukan pemain itu dalam sesi latihan 

tertentu dibandingkan dengan sesi sebelumnya. Namun untuk seorang atlet yang aktivitas 

utamanya adalah berlari, akan ada korelasi yang kuat antara jarak tempuh dan Body Load.  

 

 

 

 

 

 

 

 



 

Kartono Pramdhan, 2021 
DAMPAK TACTICAL PERIODIZATION DAN POSISI PEMAIN TERHADAP RESPON FISIOLOGI 
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

 

91 

 

 

 

 

3.1.1.3 Definisi Operasional Variabel Posisi Pemain  

 

Gambar 3.4. Profil Pemain Sepakbola Elite di Eropa 

Terlihat dari gambar 3.3. bahwa rata-rata jarak tempuh yang diperoleh pemain 

selama pertandingan menunjukan perbedaan sesuai dengan posisi. Rata-rata data dalam 

beberapa literatur menunjukkan bahwa pemain sepakbola profesional mencakup jarak 

mulai dari 10-13km sementara kiper lari 4-6km per game (Carling, 2012). (Barnerat et 

al., 2002) menyatakan bahwa pemain dapat menempuh jarak antara 10 dan 13 km dalam 

satu pertandingan, berikut rincian dilihat dari beberapa posisi: 

• Central defenders: 8-10 km  

• Defenders/outside midfielders: 9 - 2 km  

• Midfielders: 11-13 km 

• Attackers: 9 - 0 km. 5 sampai 6 km 

Kemudian dari keseluruhan aktivitas dirinci menjadi beberapa gerakan 

diantaranya:  

• 5 to 6 km Berjalan atau lari kecepatan lambat (60 sampai 70% MHR)  

• 2,5 sampai 3,5 km Kecepatan sedang hingga kecepatan tinggi (80 sampai 90% 

MHR),  

• 1,5 sampai 2,5 km Intensitas pada anaerobik ambang rangsang/treshold (90 sampai 

100% MHR)  
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• 600 sampai 1200 m berlari (50 sampai 70 sprint) 

•  300 sampai 400 m berlari mundur.  

Jarak yang ditempuh oleh pemain dalam pertandingan elite adalah sekitar 10.000 

- 12.000 meter per pertandingan tanpa perbedaan yang signifikan antara posisi. 

 

3.1.2 Validitas Internal dan eksternal 

Pada desain faktorial yang merupakan metode eksperimen, didalamnya terdapat 

variabel yang tidak terkontrol, dimana hal ini mempengaruhi terhadap  suatu validitas 

daripada eksperimen tersebut. Dalam hal ini validitas dalam penelitian eksperiman 

terdapat validitas internal dan validat eksternal. Validitas eksternal perubah dari 

kelompok diluar dari penelitian itu sendiri. 

3.1.2.1 Validitas Internal 

Yang perlu diparhatikan pada variabel internal adalah mengamati perubahan variabel 

terikat, yang diakibatkan dari varaibel bebas yang dimanipulasi. Didalam desain faktorial 

terdapat validitas internal dimana validitas ini tidak dapat dikontrol, misalnya saja: 

pengaruh bias pengumpulan data, pengaruh lokasi, pengaruh karakteristik pengumpulan 

data, pengaruh sikap subjek dan pengaruh implementasi  (Fraenkel et al., 2013). 

1) Pengaruh Lokasi 

Menggunakan alternatif berbagai tempat penelitian merupakan suatu usaha agar 

tidak mempengaruhi hasil dari penelitian. Apabila lapangan tidak dapat digunakan 

karenakan cuaca atau hal lainnya maka dapat menggunakan lapangan indoor. 

1) Pengaruh Karakteristik Pengumpulan data 

Agar tidak terjadi pengaruh atau mengganggu terkait pengumpulan data terhadap 

hasil penenelitian maka instrument yang sama dari setiap tes aau pengambilan data maka 

instrument yang dugunakan harus sama. 

2) Pengaruh Bias Pengumpulan Data 

Dengan menggunakan jumlah tes dan karakter dari tes untuk pengumpukan data akan 

membantu agar pengumpulan data tidak bias. 

3) Pengaruh sikap Subjek 
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Agar tidak terjadi pengaruh sikap subjek dalam penelitian, maka usaha yang 

dilakukan adalah peneliti mempersiapkan air minum bila subjek merasa Lelah, sehingga 

waktu dan usaha yang diharapkan untuk menerapkan treatment penelitian dapat 

maksimal. 

4) Pengaruh Implementasi 

Untuk memaksimalkan hasil penelitian maka agar tidak terjadi pengaruh perlakuan 

penelitian maka perlakuan yang diberikan harus sama kepada subjek-subjek penelitian. 

Pengaruh implementasi ini pelatih dari Tim elite kelompok eksperimen 1  dan tim elite 

kelompok eksperimen 2 merupakan pelatih yang professional dengan memiliki Lisensi 

kepelatihan yang sama yaitu PRO UEFA. 

 

3.1.2.2 Validitas Eksternal 

1) Validitas Populasi 

Validitas ini bertujuan agar karakteristik dari sampel penelitian dapat mewakili 

populasi dari penelitian. Pada penelitian ini sampel diabil secara acak/random, 

mengambil sampel tim elite kelompok eksperimen 1 dan tim elite kelompok eksperimen 

2  dengan memberikan perlakuan penelitian . 

2) Validitas Ekologi 

Dikontrol dengan mnggunakan program latihan yang direncanakan dan dijadwalkan 

dengan jelas untuk mempersipakan Kompetisi/Liga Sepakbola Indonesia dengan 

didukung sarana prasarana yang memadai, tidak memberitahu kepada pemain yang 

notabene partisipan penelitian bahwa mereka sedang dijadikan subjek penelitian, hal ini 

dilakukan untuk menghindari penaruh reaktif akibat prodes penelitian. 

 

3.2 Partisipan  

Pada penelitian ini partisipan yang digunakan adalah tim elite liga Indonesia yang 

terdiri 2 tim elite liga Indonesia. Waktu yang digunakan dalam penelitan selama tiga 

bulan dari Januari 2020 sampai Maret 2020 dengan jumlah pertemuan sebanyak 8 minggu 

untuk meerapkan perlakuan penelitian dengan menggunakan tactical periodization. 

Tempat penelitian tidak dapat disebutkan berkaitan dengan kode etik. 
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3.3 Populasi dan Sampel 

3.3.1 Populasi 

Populasi adalah kelompok penelitian yang akan digeneralisasikan hasilnya 

(Fraenkel et al., 2013, hlm. 91). Berhubungan dengan sekelompok subjek yang diperlukan 

oleh peneliti, populasi merujuk pada keseluruhan kelompok dari mana sampel-sampel 

diambil. Berdsarakan pernyataan tersebut maka populasi yang digunakan dalam 

penelitian ini adalah tim elite Liga sepakbola Indonesia pada Liga 1 dan Liga 2 sebanyak 

18 tim peserta Liga 1 dan 18 peserta Tim Liga 2. Dari kebutuhan penelitian dikarenakan 

pada respon fisiologi harus menggunakan instrument Catapult dalam memperoleh data 

maka dari hasil observasi terdapat ada 4 tim elite Liga 1 yang menggunakan alat Catapult 

pada saat latihan dan pertandingan. Kemudian terdapat 1 tim elite Liga 2 yang 

menggunakan alat Catapult pada saat latihan dan pertandingan. Sehingga populasi ini 

sebanyak 5 tim elite Liga Indonesia. Berdasarkan kode etik peneliti tidak dapat 

menyebutkan tim mana saja yang menggunakan catapult baik pada tim elite Liga 1 dan 

tim elite Liga 2. 

3.3.2 Sampel 

Sampel merupakan bagian kecil dari populasi untuk memperoleh informasi dari 

penelitian yang dilakukan (Fraenkel et al., 2013, hlm. 91).Kemudian berdasarkan kepada 

desain penelitian yang mengharuskan sample di random, dalam penelitian ini 

menggunakan teknik penggunaan simple random sampling. Simple random sampling 

adalah sampel di mana setiap anggota populasi memiliki kesempatan yang sama dan tidak 

bergantung untuk dipilih (Fraenkel et al., 2013, hlm. 94). Maka hasil yang diperoleh 

disesuaikan dengan teknik penggunaan sampel yang digunakan maka pada kelas 

eksperimen berada pada salah satu tim elite Liga 1 dan kelas ekpserimen 2 berada pada 

tim elite Liga 2 yang masing-masing jumlah pemain sebanyak 24 pemain. Namun 

demikian penelitian ini membatasi secara general berdasarkan kepada posisi pemain 

belakang, tengah dan depan. Ini berkaitan dengan kode etik karena kedua tim tidak 

memberikan izin untuk menampilkan data secara rinci dari setiap pemain. 
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Berdasarkan kepada desain penelitian menggunakan moderator dari kode etik data 

yang diperoleh karena dari semua tim tidak memberikan data detail setiap pemainnya dan 

melihat hasil output hasil catapult bahwa menampilkan data pada posisi pemain belakang, 

posisi pemain tengah dan posisi pemain depan maka ketiga posisi tersebut dijadikan 

variable moderator. Dalam permainan sepakbola yang memiliki moment seperti 

penyerangan (Attack), Bertahan (Deffend), Transisi dari bertahan ke menyerang dan 

Transisi menyerang ke bertahan. Secara garis besar sepakbola terdiri dari beberapa sektor 

posisi pemian seperti: belakang, tengah, dan depan. Dengan adanya pembagaian posisi 

tersebut dirasakan akan memberikan perbedaan performa dalam setiap sektor posisi 

tersebut. Sehingga akan berbeda kemampuan dari fisiologis pemain tersebut. Pemain 

Belakang sesuai dengan moment sepakbola adalah bertugas untuk menghadang lawan 

membangun serangan dan mencegah lawan untuk mencetak gol, pemain tengah bertugas 

untuk menjadi keseimbangan untuk selalu antisipasi bertahan ketika hilang bola dan 

menyerang pada saat tim menyerang, pemain depan memiliki tugas utama untuk 

mentelesaikan serangan untuk mencetak goal. Namun pada hakekatnya semua posisi 

pemain harus menerapkan tiga moment dalam sepak bola yaitu semua pemain paham 

bagaimana menyerang, bertahan dan transisi (Danurwindo et al., 2017) . berikut di bawah 

ini gambar zona permainan dari unit posisi pemain dalam pertandingan. 

 

Gambar. 3.5. Gambar Area lapangan Sesuai Posisi Pemain (Di Salvo et al., 

2007). 

Berikut adalah beberapa hal yang dipertimbangkan tugas dari masing-masing posisi 

pemain (Wiemeyer, 2003). : 
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• Goalkeeper : Kemampuan memiliki reaksi yang bagus pada saat tim keserang, 

bermain dengan tim terutama pada saat membangun serangan, ketenangan. 

• Posisi Pemain Belakang (Deffender) : Pemahaman taktik yang flexible, dapat 

membangun serangan, heading bertahan, pandangan yang luas selama 

pertandingan, kepemimpinan dalam lini pertahanan, bagus 1 v 1 dalam bertahan, 

kualitas transisi dari bertahan ke menyerang, kecepatan  

• Posisi Pemain Tengah (Mildfielder) : Pehamanan dan pandangan yang selalu luas 

selama pertandingan, Memiliki fisik yang bagus, skill individu yang bagus, 

kemampuan Shooting jarak jauh, Kecepatan dan daya jelajah yang tinggi, 

penguasan bola, perilaku taktik yang tinggi, kemampuan berlari, pemahaman 

dalam penyerangan dari samping, memiliki kemampuan heading menyerang  

• Posisi Pemain Depan (Striker): Memiliki Kualitas Shooting yang bagus, 

kemampuan heading menyerang untuk cetak goal, memiliki skill yang tinggi, 

bagus 1 lawan 1. 

 

3.4 Instrumen Penelitian 

Instrument penelitian adalah suatu fasilitas atau alat pada penelitian yang digunakan 

oleh peneliti untuk pengumpulan data. Oleh karenanya suatu instrument penelitian sangat 

dapat memberikan pengaruh terhadap suatu keberhasilan penelitian, maka dari itu dalam 

penyusunan instrument suatu penelitan harus disusun dan dirancang dengan baik agar 

memperoleh hasil yang maksimal dan sesuai dengan fungsi dan kegunaanya. 

Terdapat dua cara dalam menentukan atau memilih instrument yaitu dengan instrument 

yang telah ada dan atau yang dikembangkan oleh sendiri(Fraenkel et al., 2013, hlm. 113). Pada 

penelitian ini instrument yang digunakan adalah menggunakan Catapult Support. 

Catapult hadir untuk membangun dan meningkatkan performa atlet dan tim di semua 

level olahraga. Teknologi yang dikembangkan oleh Catapult awalnya dirancang untuk 

menjawab pertanyaan mendasar dalam performa olahraga.  
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Gambar 3.6. Perlengkapan Catapult yang Digunakan pada Pemain 

 

Untuk hasil output Catapult secara kesuluruhan sebagai contoh dapat dilihat dari 

gambar dibawah ini: 

 

Gambar 3.7. Hasil Output Respon Fisiologi Menggunakan Catapult 

3.5 Prosedur Penelitian 

Dalam prosedur penelitian ini dipaparkan bagaimana langkah-langkah yang 

digunakan peneliti dalam Menyusun penelitian yang akan dilakukan. Langkah-langkah 

yang ditempuh di dalam penelitian ini adalah sebagai berikut: 

1) Pembuatan rancangan penelitian. 

Dalam tahap ini langkah-langkah yang diambil berkaitan dengan penyusunan 

proposal penelitian diantaranya adalah: memilih masalah penelitian, pendahuluan yang 

dituangkan ke dalam latar belakang, perumusan masalah penelitian sesuai dengan latar 
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belakang, tujuan penelitian, perumusan kerangka pemikiran dan hipotesis, pemilihan 

metode penelitian, menentukan sumber data, perancangan instrument penelitan, dan 

Teknik yang diguakan dalam analisis data untuk menguji hipotesis penelitian. 

2) Pelaksanaan penelitian 

Dalam tahap ini langkah–langkah yang diambil merupakan proses sebelum 

memasuki kegiatan penelitian di lapangan dan pengumpulan data yang akan digunakan 

sesuai dengan instrumen yang akan digunakan. Langkah-langkah yang dilalui terdiri dari: 

bimbingan kepada promotor, kopromotor, dan anggota, penyusunan kembali instrumen 

penelitian agar dapat memenuhi kriteria instrumen yang baik dengan adanya validitas dan 

reliabilitas yang memenuhi syarat, pengumpulan data dengan menggunakan instrumen 

yang telah diuji validitas dan reliabilitasnya, analisis data sesuai dengan uji hipotesis yang 

telah diajukan, dan membuat kesimpulan dari hasil penelitian yang telah diperoleh. Untuk 

lebih jelasnya langkah-langkah yang akan ditempuh dalam penelitian ini dapat dilihat 

pada gambar berikut ini: 

 

 

 

  Populasi    

     

  Tim Liga Elite   

     

  Sampel    

     

Tactical Periodisasi 

Kelompok Eksperimen 1 

 Tactical Periodisasi 

Kelompok Eksperimen 2 

     

Respon Fisiologi  

(Post-Test) 

  Respon Fisiologi  
(Post-Test) 

     

  Pengolahan dan Analisis Data   

     

  Kesimpulan   

 

Gambar 3.8. 

Langkah-Langkah Pengumpulan Data 
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3) Pembuatan Laporan Penelitian 

Pada tahap peneliti menulis laporan sesuai dengan data yang telah didapatkan selama 

proses penelitian. 

 

3.6 Analisis Data 

Pada penelitian ini menggunakan tim elite peserta Liga Indonesia dimana para 

pemainnya sebagai subjek penelitian dan disebut juga sebagai partisipan, partisipan 

dalam penelitina ini adalah para pemain profesioanl yang bermain pada tim elite Liga  

sepakbola Indonesia. 

Data yang akan di analisis dalam penelitian ini adalah hasil dari penggunaan 

instrument penelitian yang telah dipaparkan diatas. Dibawah ini merupakan Teknik yang 

digunakan dalam penganalisisan data :  

Data yang akan di analisis dalam penelitian ini adalah hasil dari penggunaan 

instrumen penelitian yang telah dipaparkan di atas. Berikut teknik yang digunakan dalam 

penganalisisan data: 

3.6.1 Rata-rata, Simpangan Baku, dan Varian 

Untuk perhitungan rata-rata, simpangan baku, dan varian dengan menggunakan 

aplikasi IBM Statistical Package for the Social Sciences (SPSS) Statistic. Tahapan 

perhitungan yang akan dilakukan dengan langkah-langkah sebagai berikut: klik Analyze 

> Descriptive Statistics > Descpriptives > Masukan semua variabel ke kotak Variabel 

(s) > Options > ceklis Mean, Std. Deviation, dan variance > Continue > OK. 

 

3.6.2 Uji Normalitas 

Uji normalitas salah satu uji prasayaratan yang digunakan untuk mengetahui 

apakah data tersebut berdistribusi normal atau baik. Uji normalitas menggunakan 

shapiro-wil atau Kolmogorov-smirnov dengan bantuan IBM Statistical Package for the 

Social Science (SPSS) Statistics. Tahapan perhitungan yang akan dilakukan dengan 

Langkah sebagai berikut: klik Analyse > Descriptive Statistics > Descriptives > Explore 
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> Masukan semua variabel ke kotak Dependent List > Plots > ceklis Normality plots with 

test > Continue > OK. Format pengujiannya dengan membandingkan nilai probabilitas 

(p) atau signifikansi (Sig.) dengan derajat kebebasan (dk) α = 0,05. Uji kebermaknaannya 

sebagai berikut: 

1) Jika nilai Sig. atau P-value > 0,05 maka data dinyatakan normal. 

2) Jika nilai Sig. atau P-value < 0,05 maka data dinytaakan tidak normal. 

Uji normalitas salah satu uji prasyarat yang digunakan untuk mengetahui apakah 

data tersebut berdistribusi normal atau baik. Uji normalitas menggunakan shapiro-wilk 

atau kolmogorov-smirnov dengan bantuan IBM Statistical Package for the Social 

Sciences (SPSS) Statistics 22. Tahapan penghitungan yang akan dilakukan dengan 

langkah-langkah sebagai berikut: klik Analyze > Descriptive Statistics > Descriptives > 

Explore > Masukan semua variabel ke kotak Dependent List > Plots > ceklis Normality 

plots with tests > Continue > OK. Format pengujiannya dengan membandingkan nilai 

probabilitas (p) atau signifikansi (Sig.) dengan derajat kebebasan (dk) α = 0,05. Uji 

kebermaknaannya sebagai berikut: 

1) Jika nilai Sig. atau P-value > 0,05 maka data dinyatakan normal. 

2) Jika nilai Sig. atau P-value < 0,05 maka data dinyatakan tidak normal. 

 

3.6.3 Uji Homogenitas 

Uji homogenitas digunakan untuk mngetahui apakah suatu data atau sampel yang 

diambil bersalah dari varian yang homogen atau tidak. Uji homogenitas dilakukan sebagai 

prasyarat dalam uji MANOVA. Uji homogenitas menggunakan Lavene Statistics dengan 

bantuan IBM Statistical Package for the social Science (SPSS) Statistis. Tahapan 

perhitungan yang akan dilakukan debgan Langkah-langkah sebagai berikut : klik Analyze 

> Compore Means > One-Way ANOVA > MAsukan variabel ke kotak Dependent List > 

Masukan faktor ke kotak Factor > Options > Homogenity of variance test > Continue > 

OK.  Formatpengujiannya dengan membandingkan nilai probalitas (p) atau signifikan 

(Sig.) dengan derajat kebebasan (dk) α = 0,05. Uji kebermaknaannya sebagai berikut: 

1) Jika nilai Sig. atau P-value > 0,05 maka data dinyatakan homogen. 

2) Jika nilai Sig. atau P-value < 0,05 maka data dinyatakan tidak homogen. 
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3.6.4 Uji Hipotesis 

Uji hipotesis yang digunakan dalam penelitian ini menggunakanh uji MANOVA 

dengan bantuan IBM Statistical Package for the Social Science (SPSS) Statistics. 

Tahapan perhitugan yang akan dilakukan dengan langkah-langkah dibawah ini: 

1) Variabel Independen: 1. “Tactical Perisodization” dengan kategori tim elite 

eksperimen 1 dan tim elite eksperimen 2. Measure = Nominal, Decimals = 0, Type 

= Numeric, dan isi Values: 1 = Kelompok Eksperimen 1, 2 = Kelompok eksperimen 

2. 

2) Variabel independen: 2. "Posisi Pemain" dengan kategori posisi pemain belakang, 

posisi pemain tengah dan posisi pemain depan. Measure = Nominal, Decimals = 0, 

Type = Numeric, dan isi Values: 1 = Tinggi, 2 = Rendah. 

3) Variabel dependen: "Respon Fisiologi". Measure = Scale, Decimals = 0, Type 

= Numeric, 

Setelah langkah-langkah diatas lalu klik Analyze > General Linear Model 

> Multivariate > Masukan data respon fisiologi yang terdiri dari (1). Distance, (2). Speed 

Maksimal, (3). Speed Avarage, (4). Body Load, (5). Hate Rate Avarage, (6). Hate Rate 

Maksimal  ke kotak Dependent Variable, masukan Tactical Periodization dan  posisi 

pemain ke kotak fixed factor (s) > klik plot  masukan masukkan Tactical Periodization  ke 

kotak Horizontal Axis dan posisi pemain  ke  

kotak Separate Lines > add > continue > klik Post Hoc, Masukan masukkan Tactical 

Periodization   dan posisi pemain ke kotak Post Hoc Test for > Tukey > continue > klik 

Options > Desriptive statistics > Estimates of effect size > Homogeneity tests >continue 

> klik OK. Uji kebermaknaannya sebagai berikut: 

1) Tactical Periodization: Pengaruh Tactical Periodization terhadap respon 

fisiologi. Apabila Signifikansi (Sig.) <0,05 (Alfa)= Signifikan. 

2) Posisi pemain: Pengaruh Posisi pemain terhadap aktivitrespon fisiologi. Apabila 

Signifikan (Sig.) < 0,05 (Alfa) = Signifian  
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3) Tactical Periodization*Posisi pemain: Pengaruh kemampuan Tactical 

Periodization*Posisi pemain terhadap respon fisiologi. Apabila Signifikan (Sig.) 

<0,05 (Alfa) = Signifian 

4) Error: Nilai Error model, semakin kecil maka model semakin baik  

Dengan demikian berdasarkan tata cara perhitungan hipotesis statistic diatas yang 

diajukan dalam penelitian ini adalah sebagai berikut: 

1) Ho: µA1   = µA2 

Hi: µA1   > µA2 

2) Ho: Interaksi A x B = µA2 

Hi: Interaksi A x B ≠ µA2 

3) Ho: µA1B1  = µA2B1 

Hi: µA1B1  > µA2B1 

4) Ho: µA1B2  = µA2B2 

Hi: µA1B2  > µA2B2 

5) Ho: µA1B3  = µA2B3 

Hi: µA1B3  > µA2B3 

Keterangan: 

µA1 : Rata-rata respon fisiologi dengan Tactical periodization pada tim elite 

kelompok eksperimen 1 

µA2 : Rata-rata respon fisiologi dengan Tactical periodization pada tim elite 

kelompok eksperimen 2 

µA1B1 : Rata-rata respon fisiologi dengan Tactical periodization pada tim elite 

kelompok eksperimen 1 posisi pemain belakang. 

µA2B1 : Rata-rata respon fisiologi dengan Tactical periodization pada tim elite 

kelompok eksperimen 2 posisi pemain belakang. 

µA1B2 : Rata-rata respon fisiologi dengan Tactical periodization pada 

kelompok eksperimen 1 posisi pemain tengah. 

µA2B2   : Rata-rata respon fisiologi dengan Tactical periodization pada tim elite 

kelompok eksperimen 2 posisi pemain tengah. 

µA1B3 : Rata-rata respon fisiologi dengan Tactical periodization pada tim elite 

kelompok eksperimen 1 posisi pemain depan. 

µA2B3 : Rata-rata respon fisiologi dengan Tactical periodization pada tim elite 

kelompok eksperimen 2 posisi pemain depan. 

 

 


